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Getting a trace with Extrae
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Extrae features

» Platforms —
= Intel, Cray, BlueGene, Intel MIC, ARM, Android, Fujitsu Sparc...

= Parallel programming model
= MPI, OpenMP, pthreads, OmpSs, CUDA, OpenCL, Java, Python...

» Performance Counters No need to
= Using PAPI interface recompile

or relink!

» | ink to source code
= Callstack at MPI routines
= OpenMP outlined routines
= Selected user functions

= Periodic samples

» User events (Extrae API)
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Extrae overheads

VIRTYUALAINSTITYUTE ~HIGHPRODUCTIVITY SUPERCOMPUTING

Event

Event + PAPI

Event + callstack (1 level)

Event + callstack (6 levels)

BSCTOOLS HANDS-ON
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How does Extrae work?

= Symbol substitution through LD_PRELOAD

= Specific libraries for each combination of runtimes
= MPI Recommended
= OpenMP

= OpenMP+MPI

» Dynamic instrumentation

= Based on DynlInst (developed by U.Wisconsin/U.Maryland)
= Instrumentation in memory
= Binary rewriting

= Static link (i.e., PMPI, Extrae API)

BSCTOOLS HANDS-ON 5
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Using Extrae in 3 steps

1. Adapt your job submission script

2. Configure what to trace

= XML configuration file
= Example configurations at $EXTRAE_HOME/share/example

3. Run it!

» For further reference check the Extrae User Guide:
= https://tools.bsc.es/sites/default/files/documentation/html/extrae/index.html
= Also distributed with Extrae at $EXTRAE_HOME/share/doc

BSCTOOLS HANDS-ON 8
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Login to Romeo and copy the examples

laptop> ssh -Y <USER>@romeologinl.univ-reims.fr
romeo> cp -r /home/laumercadal/tools-material $HOME

romeo> 1ls $HOME/tools-material
. apps/
. Clustering/

.. extrae/
. slides/ Here you have

. traces/ a copy of this slides

BSCTOOLS HANDS-ON
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Step 1: Adapt the job script to load Extrae with LD_PRELOAD

romeo> vi $HOME/tools-material/extrae/job.slurm

#!/usr/bin/env bash

#SBATCH --job-name=lulesh2.0 27p

#SBATCH --output=1lulesh2.0 27p.out R

oy equest
#SBATCH --error=lulesh2.0 27p.err reséijrces
#SBATCH --ntasks=27

#SBATCH --time=00:10:00 )

module load gcc/8.1.0 openmpi/2.0.4.1.1_gnu } Select MPI
version

export OMP_NUM_THREADS=1

srun ../apps/lulesh2.8 -i 10 -s 65 —p Run the

program

BSCTOOLS HANDS-ON 10
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Step 1: Adapt the job script to load Extrae with LD_PRELOAD

romeo> vi $HOME/tools-material/extrae/job.slurm

#!/usr/bin/env bash

#SBATCH --job-name=lulesh2.0 27p
#SBATCH --output=1lulesh2.0 27p.out
#SBATCH --error=lulesh2.0 27p.err
#SBATCH --ntasks=27

#SBATCH --time=00:10:00

module load gcc/8.1.0 openmpi/2.0.4.1.1 gnu
module load extrae/3.6.1<« Load Extrae module

export OMP_NUM_THREADS=1

export TRACE_NAME=lulesh2.6_27p.prv < Name of the

resulting trace

srun ./trace.sh ../apps/lulesh2.0 -i 10 -s 65

e Activate Extrae

during the run

BSCTOOLS HANDS-ON 11
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Step 1: Adapt the job script to load Extrae with LD_PRELOAD

romeo> vi $HOME/tools-material/extrae/trace.sh

#!/usr/bin/env bash

#SBATCH --job-name=lulesh2.0 27p
#SBATCH --output=1lulesh2.0 27p.out
#SBATCH --error=lulesh2.0 27p.err
#SBATCH --ntasks=27

#SBATCH --time=00:10:00

module load gcc/8.1.0 openmpi/2
module load extrae/3.6.1

export OMP_NUM_THREAD
export TRACE_NAME= esh2.0 _27p.prv

srun ./apps/lulesh2.0 -i 10 -s 65

BSCTOOLS HANDS-ON

7| #!/usr/bin/env bash

# Configure Extrae
export EXTRAE_CONFIG_FILE=

# Load the tracing library
export LD_PRELOAD=${EXTRAE
#texport LD_PRELOAD=${EXTRA

# Run the program
¢ *

Select
“what to trace”

./extrae.x

(choose C/Fortran)
_HOME}/1ib/libmpitrace.so
E_HOME}/1lib/libmpfR®racef.so

Select your

type of application

12
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Step 1: Which tracing library?

= Choose depending on the application type

m-m- OpenMP | pthread | CUDA _

libseqtrace

libmpitrace[f]! v

libomptrace v

libpttrace v

libcudatrace v
libompitrace[f] ! v v

libptmpitrace[f] 1 v v
libcudampitrace[f] 1 v v

1 include suffix “f” in Fortran codes

R —

BSCTOOLS HANDS-ON 13
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Step 3: Run it!

= Submit your job

romeo> cd $HOME/tools-material/extrae

romeo> sbatch job.slurm

= Once finished the trace will be in the same folder: 1ulesh2.0 27p.{pcf,prv, row}
= Check the status of your job with:

romeo> squeue -u $USER

= Any issue?
= Already generated at $HOME/tools-material/traces

BSCTOOLS HANDS-ON 14
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Step 2: Extrae XML configuration

romeo> vi $HOME/tools-material/extrae/extrae.xml

<mpi enabled="yes">
<counters enabled="yes™ />
</mpi>

Trace the MPI calls
(What's the program doing?)

<openmp enabled=“no">
<locks enabled="no" />
<counters enabled="yes" />
</openmp>

<pthread enabled="no">

<locks enabled="no" />
<counters enabled="yes" /> Trace the call-stack

</pthread> (Where in my code?)

<callers enabled="yes">
<mpi enabled="yes">1-3</mpi>
<sampling enabled="no">1-5</sampling>
</callers>

BSCTOOLS HANDS-ON
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Step 2: Extrae XML configuration (II)

romeo> vi $HOME/tools-material/extrae/extrae.xml

<counters enabled="yes">
<cpu enabled="yes" starting-set-distribution="cyclic">
<set enabled="yes" domain="all" changeat-time="500000us">
PAPI_TOT_INS, PAPI_TOT_CYC, PAPI_L1 DCM, PAPI_L3_TCM, PAPI_BR_INS
</set>
<set enabled="yes" domain="all" changeat-time="500000us">
PAPI_TOT_INS, PAPI_TOT CYC, PAPI_BR_MSP, RESOURCE_STALLS, PAPI_SR_INS

</set>
</cpu>
<network enabled="no" />
<resource-usage enabled="no" /> Select which HW counters
<memory-usage enabled="no" /> are measured
</counters>

(How's the machine doing?)

BSCTOOLS HANDS-ON
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Step 2: Extrae XML configuration (III)

romeo> vi $HOME/tools-material/extrae/extrae.xml

<buffer enabled="yes">

<size enabled="yes">5000000</size> Trace buffer size
<circular enabled="no" /> (Flush/memory trade-off)
</buffer>

<sampling enabled="no" type="default" period="50m" variability="1em" />

Enable sampling
<merge enabled="“yes"

(Want more details?)

synchronization="detganlt"
tree-fan-out="16"
max-memory="512"
joint-states="yes"
keep-mpits="yes"

Automatic
post-processing

to generate the
Paraver trace

sort-addresses="yes"

overwrite="yes">

$TRACE_NAME$
</merge>

BSCTOOLS HANDS-ON
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Installing Paraver
&
First analysis steps
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Install Paraver in your laptop

Documentation » Downloads Publications.

= Download from http://tools.bsc.es/downloads

Home » Downloads

Downloads

CORE TOOLS

EXTRAE PARAVER DIMEMAS
Instrumentation framework to generate execution Expressive powerful and flexible trace visualizer for High-abstracted network simulator for message

traces of the most used parallel runtimes. post-mortem trace analysis. passing programs.

Version 4.6.3 « 1.56 MB Version 5.2.12 « 1.09 MB
ORED L ELH 6 & 6

Pick your version

= Also available @Romeo ol wxparaver-4.7.2-win.zip

= /home/laumercadal/tools-packages

waparaver-4.7.2-mac.zip

A wxparaver-4.7.2-Linux_i686.tar.gz (32-bits)
o Wwxparaver-4.7.2-Linux_x86_64.tar.gz (64-bits)

laptop> scp @romeologinl.univ-remis-fr: \
/home/laumercadal/tools-packages/ $HOME



http://tools.bsc.es/downloads
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Install Paraver (1I)

( Home Paraver » Dimemas » Extrae Research » Documentation » Downloads Publications.

= Download tutorials:
= Documentation -> Tutorial guidelines

news@tools:~ > Paraver 4.7.2 availll

Home » Documentation » Paraver tutorials

These seven tutorials can be opened with wxParaver versions newer than 4.3.0, and you'll be able to follow the steps within the tool. To install them, download
and untar the package and follow the instructions of the Help/Tutorial option on the Paraver main window. Following there is a list of available tutorials

B Paraver introduction (MP!

-known
included)

Download links

ntroduction to Paraver anc

Dimemas methodology

1sing the provided

i
thodol o
con
@ /sis on ance analysis of the MPI application Hydro and further
sirr Dim
b _ Lo 0 select a representative region for a large trace that cannot be
ace preparatior .
o loaded into
f you ic xpected unnaligne wards communications, use this
b Trace alignment tutorial ’ P -

tutorial to learn orrect shifts between pi

= Also available @Romeo
= /home/laumercadal/tools-packages

If you prefer you can downlo2 i togheter in a single package:

zip format (127 Mb)

laptop> scp @romeologinl.univ-reims.fr:
/home/laumercadal/tools-packages/

20
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Uncompress, rename & move

= Paraver

laptop> tar xf

laptop> mv wxparaver-4.7.2-1linux-x86_64 paraver

= Tutorials

laptop> tar xf

laptop> mv paraver-tutorials-20150526 paraver/tutorials

FOOTER (INSERT > HEADER AND FOOTER) 21
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Check that everything works

= Start Paraver

laptop> $HOME/paraver/bin/wxparaver & Tutorials
Barcelona
Supercomputing
= Check that tutorials are available Center

Cantra Nacional de Supercomputacion

File Hints | Help Index

(N . 1. Introduction to Analysis with Paraver - MPI

Workspaces

INonE

Window browser
IAIITraces

2. Introduction to the Use of Dimemas

3. Introduction to Paraver and Dimemas methodology

4 Analysis with Paraver & Dimemas - Methodology

Click on Help > Tutorials

5. HydroC Tutorial

b. Paraver trace preparation

= Remotely available in Romeo

laptop> ssh -Y @romeologinl.univ-reims.fr

romeo> /home/laumercadal/wxparaver/latest/bin/wxparaver

BSCTOOLS HANDS-ON 22
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First steps of analysis

= Copy the trace to your laptop ( All 3 files: *.prv, *.pcf, *.row )

laptop> scp @romeologinl.univ-reims.fr:$HOME/tools-material/extrae/lulesh2.0* ./

Click on File 2 Load Trace

= L oad the trace ot Trate > Browse to the *.prv file

Previous Traces

» Follow Tutorial #3
(C sorcrs
Supercompuiing

File Hintz | Help Center

. Ceantra Naclonal de Supercomputacion
: . . . Help Contents...

Workspaces Tutoria Index

INDHE

1. Introduction to Analysis with Paraver - MPT

2 Introdycion to HW'H

Window browser
3. Introduction to Paraver and Dimemas methodelogy I
IAII Traces
T AnSTEIS Wi Paraver b bimemas - Memoderogy
H H 5. HydroC Tutorial
Click on Help > Tutorials

6. Paraver trace preparation

23



VIRTYUALAINSTITYUTE ~HIGHPRODUCTIVITY SUPERCOMPUTING

Measure the parallel efficiency

= Click on "mpi_stats.cfg”

_—aa——
THREAD 1161 s om% 7sw 2
3 THREAD 1.17.1 o ool% ods% 7sE%
The first question to answer when analyzing a parallel code is "how efficient does it _—_
run?". The efficiency of a parallel pregram can be defined based on two aspects: the THREAD1.18.1 -
par._a\lehzanon efficiency ._and the efficiency obtained in the execution of the serial THREAD 1.19.1 _—_-
regions. These two metrics would be the first checks on the proposed methodology. -
THREAD 1201 S eeL%  Doe%  U97%
» To measure the parallel efficiendlf load the configuration file
ctaaiaca az ttats cta e diauraton pops p 3 e with%sime et THREAD 1.21.1 o om%  1M4% 1350%
everythread spends in every MPI cfll. Look at the global statistics at the bottom of _—_
represents the application parallel THREAD1.22.1 -
efficiency, entry Avg/Max represents the global load balance and entry Maximum THREAD 1.23.1 _—_-
represents the communication efficiency. If any of those values are lower than
85% is recommended to look at the corresponding metric in detail. Open the THREAD 1.24.1 _—_-
control window to identify the phases and iterations of the code
THREAD 1.25.1 S em%  om% Se%
+ To measure the computation time distribution load the cenfiguratien file
Comnerals Thi conforaton pops up 3 THREAD 1.26.1 o oolw om% ER%
histogram of the duration for the computation regions. The computation regions _—_
are delimited by the exit from an MPI call and the entry to the next call. If the THREAD 1.27.1 -
histogram does not show vertical lines, itindicates the computation time may be
not balanced. Open the control window to look at the time distribution and visually
correlate both views. Total 2,418.03 % 257 % 166 % 4.13 % 46.88 % 0.35 % 3.8 % 200.37 %
+ To measure the compu Tl 83.56 % 0.10 % 0.06 % 0.15 % 174 % 0.01 % 0.14 % T42 %
configuration file ] » - - - .
configuration pops up a . - Maxi 33.01 % 0.21 % 0.13 9% 1.55 % 353 % 0.02 % 114 % 13.50 %
;“;“E","“Ef:f;‘f”ﬁ’;%"h”‘ B152% 0.04 % 0.03 % 0.04 % 0.37 % 0.00 % 0.00 % 0.01 %
istribufion of the Instru StDev 4.28 % 0.03 % 0.02 % 0.28 % 1.08 % 0.01 % 0.32% 3.46 %
° a - | Avg/ 0.90 f 0.46 0.42 0.10 0.49 0.53 0.13 0.55
» Tnmeasura tha sarial 1.
= = R -
= | o
s | 4
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Computation time and work distribution

= Click on “2dh_usefulduration.cfg” (2nd link) = Shows time computing

G230 [min s I 2 %
;I

The first question to answer when analyzing a parallel code is "how efficient does it
run?”. The efficiency of a parallel program can be defined based on two aspects: the
parallelization efficiency and the efficiency obtained in the execution of the serial 1

regions. These two metrics would be the first checks on the proposed methodology. I I /

s To measure the parallel efficiency load the configuration file I
cfgesnpisnpl stats cfgThis configuration pops up a table with %time that I I I
every thread spends in every MPI call. Look at the global statistics at the bottom of I
the outside mpi column. Entry Average represents the application parallel
efficiency. entry Avg/Max represents the global load balance and entry Maximum
represents the communication efficiency. If any of those values are lower than I
85% is recommended to look at the corresponding metric in detail. Open the
control window to identify the phases and iterations of the code I

To measure the computation time distribution [{ed the configuration file I I
cfgsrgeneral ~2dh_ussfulduration of g This §onfiguration pops up a
histogram of the duration for the computation regiofls. The computation regions

- y to the next call. If the
histogram does not show vertical lines, it indicates the computation time may be
not balanced. Open the control window to look at the time distribution and visually
correlate both views

N

e To measure the computational load (instructions) distribution load the
configuration file cf g=rpapi 2dh_ussful instructions ofg This
configuration pops up a histogram of the instructions for the computation regions.
The computation regions are delimited by the exit from an MPI call and the entry
to the next call. If the histogram doesn't show vertical lines, itindicates the
distribution of the instructions may be not balanced. Open the control window to
look at the time distribution and correlate both views

a Tn measure the serial reninns narfarmance Innk at the TPC timeline Inaded _I

=l = -

N

i

BSCTOOLS HANDS-ON 25
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Computation time and work distribution

and “2dh_useful_instructions.cfg” (3rd link) = Shows amount of work

|§|@'||_:=@o|l_l_” il E
=

The first question to answer when analyzing a parallel code is "how efficient does it
run?”. The efficiency of a parallel program can be defined based on two aspects: the
parallelization efficiency and the efficiency obtained in the execution of the serial ‘
regions. These two metrics would be the first checks on the proposed methodology. II /

s To measure the parallel efficiency load the configuration file I I/
cfgesnpisnpl stats cfgThis configuration pops up a table with %time that
every thread spends in every MPI call. Look at the global statistics at the bottom of /
the outside mpi column. Entry Average represents the application parallel
efficiency. entry Avg/Max represents the global load balance and entry Maximum [ |
represents the communication efficiency. If any of those values are lower than I
85% is recommended to look at the corresponding metric in detail. Open the
control window to identify the phases and iterations of the code

e To measure the computation time distribution load the configuration file
¥ Vi This configuration pops up a
histogram of the duration for the computation regions. The computation regions
are delimited by the exit from an MPI call and the entry to the next call. If the
histogram does not show vertical lines, it indicates the computation time may be
not balanced. Open the control window to look at the time distribution and visually
correlate both views

e To meaglire the computational load (instructions) distribution lofl the
configurgon file cfgsrpani 2dh _ussful instructions ofg Thi
configuraon pops up a histogram of the instructions for the computat@n regions.

to the next call. If the histogram doesn't show vertical lines, itindicates the
distribution of the instructions may be not balanced. Open the control window to
look at the time distribution and correlate both views

a Tn measure the serial reninns narfarmance Innk at the TPC timeline Inaded LI Wo rk I

=l = o |

imbalance .879.970.26413)
(zig-zag)

BSCTOOLS HANDS-ON 26
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Where does this happen?

= Go from the table to the timeline

. . 5 ins ions 2 E . 1,4.73832 ) @ sn2.o _27p.
R R S e 1M’E_Shzu_eful instructions 2DZoom range [1.96919e+008,4.73832e+008) @ lulesh2.0 27p.prv

. THREAD 1.1.1
oyl || 1 o< 10

THREAD 1.10.1

CIiCk (0] 9] THREAD 1.10.1
"Open Filtered THREAD 127.1  —

410,078,3. 5.86 - 414,960,273.33

Control Window”

Right click = Fit

| Semantic Scale =
Select this area Fit both

(by drag-and-dropping)

[873,816,643 34 879,970,264 13)

FOOTER (INSERT > HEADER AND FOOTER)
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Where does this happen?

. m &m at the same time = Imbalance

useful instructions 20Zoom range [l.98910e+008,4.73832e+008) @ lulesh2.0 27p.prv

2dh useful instructions @ lulesh:

IE B 59 ||_Jl'§) HTI? T THREAD 1.1.1

THREAD 1.10.1

Zoom into

1 of the iterations
(by drag-and-dropping)

useful instructions 2DZoom range [1.96919e+008,4.73832e+008) @ lulesh2.0 27p.prv
[ THREAD 1.1.1

Il!. THREAD 1.10.1

[373,816,648.94..879,970,264.13) T

THREAD 1.2T.1

FOOTER (INSERT > HEADER AND FOOTER) 28
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Where does this happen?

» Hints &> Callers - Caller function

FOOTER (INSERT > HEADER AND FOOTER)

useful instructions 2DZcom range [1.96919e+008,4.73832e+008) @ lulesh2.@ 27p.prv

THREAD L.1.1

THREAD 1.10.1

THREAD 1.19.1

THREAD 1.27.1

MPI caller @ lulesh2.@ 27p.prv

THREAD 1.1.1
THREAD 1.5.1
THREAD 1.9.1
THREAD 1.13.1
THREAD 1.1T.1
THREAD 1.21.1

THREAD 1.25.1
THREAD 1.27.1

CommSend | CommMonoQ

Timelncrement

Right click 2>
Copy

Right click 2>
Paste 2 Time

29
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Save CFG’s (2 methods)

Copy CTRL+C

Paste 3
—

Clone

Right click on
timeline

useful instructions 2DZoom range [1.96919e+008,4.73832e+008) @ lulesh2.0 27p.prv

THREAD 1.1.1

Undo Zoom CTRL+L

THREAD 1.10.1

THREAD 1.19.1

THREAD 1.27.1 - p— Fit Time Scale

14850

Fit Semantic Scale 2
Fit Objects
Select Objects...

View

Paint As
Drawmode
Pixel Size
Object Labels
Object Axis

b . . . .

Run 2

Synchronize +

| _save | Configuration.

. Image...
Timing CTRL+T
Image Legend...
Info Panel

Text. ..

FOOTER (INSERT > HEADER AND FOOTER) 30



Save CFG’s (2 methods)

VIRTYUALAINSTITYUTE ~HIGHPRODUCTIVITY SUPERCOMPUTING

useful instructions 2DZoom range [1.96919e+008,4.73832e+008) @ lulesh2.0 27p.prv
THREAD L.1.1

THREAD 1.10.1

THREAD 1.12

1. Main Paraver

window

File Hints Help
Load Trace
Previous Traces »

Unload Traces..

Load Configuration

Previous Configurations

Load Session
Save Session CTRL+S

Preferences,
ith

Quit

T 20h useful nstructions
B useful instruction
&1 83 MPI caller

< |

FOOTER (INSERT > HEADER AND FOOTER)

ave configuration

flulesh2.0_27p.prv

Timelines

=

Histograms

useful instructions @ Iulesh2.[]_;|
Instructions.cl @ lulesh2.0_27¢
 Useful.cl @ lulesh2.0_27p.prv

seful instructions i
structions.clcl @ lulesh2.0_
seful clcl @ lulesh2 .0 27p.pr
caller @ lulesh2.0_27p.prv
MPI caller @ lulesh2.0_27¢
call @ lulesh2.0_27p.prv 77

Unset all

Description

2. Select

MPI call profile @ lulesh2.0_27p.prv
2DH useful duration correlated witl
2dh useful instructions @ lulesh2.0

Set all Unset all I

[~ Save whole CFGin basic mode

~ Timeline options

¥ Relative begin time
¥ Relative end time

l Compute semantic scale

— Histogram options
@ All trace
© All window

v Compute gradient limits

-

Save Cancel |
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CFG’s distribution

= Paraver comes with many more included CFG's

File Hints Help

Load Trace...
Previous Traces »

Unload Traces...

Load Configuration...

Previous Configurations O Look in: IE' cfgs j ﬁl ﬂl [r:ll gl?

Save Configuration...

Load Session... CTRL+I - —= ' . .
Save Session . CTRL+S burst_mode |_DJ ava |_D sampling+folding
Preferences... _ cluste FiI'IEI h I'I'IFII h S5C riptE
ith N N N
Quit counters_PAPI |_D Omp5s |_D software_counters

| 2dh useful instructions
-- €3 useful instructions 2DZoom range [1.601542+0(
(- €3 MPI caller

] CUDA IS opencL IS spectral
I folding [ openMp
( | &l | General IS pthread

Files & Window Properties

-] lib -]
D libbsctools )

-] share File name: j DOpen
D src =

D Telegram J .
:g“mﬂiﬁf Files of type: Paraver configuration file (*.cfg) j Cancel
-
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Hints: a good place to start!

= Paraver suggests CFG’s based on the information present in the trace

File | Hints Help

HE MPI profile

Work: callers p Point 2 point connectivity pattern

IF HWC » Histogram of durations per MPI call
flush W Histogram of message sizes per call

Windoworowser

| lulesh2.0_27p.prv |

-~ MPI call
- MPI call prafile
../ =8 Useful Duration
- % Instructions per cycle
-] 2DH useful duration correlated with
[#- &3 useful instructions
-] 2dh useful instructions
- &8 useful instructions 2DZoom range [1.60154e+0(
- &8 MPI caller

1| |

Files & Window Properties

= lib B
&[] libbsctools

&[] share

&[] sre

&[] Telegram J
&£ uncrustify

i m, B huret_mada

Ledle

Paraver files
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Cluster-based analysis
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Use clustering analysis

= Run clustering

romeo> module load clustering/2.6.8
romeo> cd $HOME/tools-material/clustering

romeo> BurstClustering -d cluster.xml -i ../extrae/lulesh2.0 27p.prv \
-0 lulesh2.0 _27p clustered.prv

= If you didn’t get your own trace, use a prepared one from:

romeo> 1ls $HOME/tools-material/traces/lulesh2.0 27p.prv

= Copy the results to your computer

laptop> scp @romeologinl.univ-reims.fr:$HOME/tools-material/clustering/* ./
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Cluster-based analysis

= Check the resulting scatter plot

laptop> gnuplot lulesh2.0_27p clustered.IPC.PAPI_TOT_INS.gnuplot

n i i i Cluster Analysis Results of trace 'lulesh2.0,7p.prnv’
Identify main computing trends e e 2 2
1.2x107 T+ T Noise + Cluster11 <
Cluster 1 Cluster 12
= Work (Y) VS. Speed (X) 1x10° - ’ 41  Cluster2 Cluster 13
o Cluster3 O Cluster14 ®
D 8 Cluster4 ® Cluster15 +
E— 8x10° I~ ] Cluster5 O Cluster 16
5] Cluster6 @ Cluster 17
» Look at the clusters shape § ool B 1 duters Ceter1s O
. .y . . . = o
= Variability in both axes indicate g S Cluster® Cluster1s ®
potential imbalances £ 4x10° k) Cluster 10 Cluster21 @
a e
2x108 'g
©
>
0
0
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Correlating scatter plot and time distribution

= Open the clustered trace with Paraver and look at it

laptop> $HOME/paraver/bin/wxparaver /lulesh_27p clustered.prv

= Display the distribution of clusters over time
» File > Load configuration > $HOME/paraver/cfgs/clustering/clusterID_window.cfg

Cluster Analysis Results of trace 'lulesh2.0,7p.prv'
DBSCAN (Eps=0.01, MinPoints=4)
— 3 i s
Variable work / 1.2x10 — oise 4+ Cluter1l o
Cluster 1 Cluster 12
Speed 1x10° ’ - Cluster 2 Cluster 13
Cluster3 O Cluster14 ®
+ 8 Cluster4 m Cluster 15+
. 8x10% - ] Cluster5 © Cluster16
Simultaneously @ Cluster6 ®  Clusterl7
d ff 6x 10 i, Cluster 7 Cluster18 O
H Cluster 8 Cluster19 m
! erent processes s Cluster 9 Cluster20 ©
= 4x10° - 7 Cluster 10 Cluster21 @
B
Imbalances 2x10° - 1
° ‘m
0 Al I I I
0 0.5 1 15 2 25 3
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